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Part 1
RIBBASIC Training guide

~ How to make 3D object ~ 

by MODELA



2

Prepare items

• Users manual (See P7, P11~14, P68) 

• PC　(System requirements Pentium 200MHz HDD 1GB,  Memory 64MB）

• OS  Windows 95/98/ME/NT4.0/2000

• MDX-20 or MDX-15

• Accessories of MDX-20/15 (Spindle Unit, Cap screw for spindle unit x 2, Endmill, Set screw 
for endmill x 1, Double-sided tape, Positioning pins x 3, Hexagonal wrench for 3mm, 1.5mm)
　　　　　　　　　　　　　　

• 3D-CAD or CG software

• Roland Software Package (RSP-009 ver.1.6 or over)　
– RSP-009 includes MODELA Player, Virtual MODELA, Windows Driver

• RS-232C serial cable, XY-RS-14 or XY-RS-34

• Material (SAN MODUR, Chemical wood, wax etc. SAN MODUR->See Appendix 1 )

• Vacuum cleaner

• Slide calipers or ruler
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Sample for Training

3D-CAD Data

Object Front face Object Reverse Side Complete object
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Workflow 

Create 3d data 

Simulation by VirtualMODELA 　

Create tool path by 

MODELA Player 

Cutting by MDX-20 or MDX-15
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Training guide (Please refer users manual)

1. Create cutting data

Use your 3D CAD or CG software and create 3D data.　

The software should be able to export data to DXF 
or STL format.

This sample object is created by Rhinoceros (3D CAD)

2. Add support ribs

Add ribs to 3D data for the cutting of reverse side. 

3. Export 3D data to STL or DXF format.

MODELA Player can import the file in DXF format 
or STL format.

4. Save your 3D CAD or CG software.　　

Support rib
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5. Start MODELA Player　

　　　　　　　　　　

Click [start] of Windows menu. Point to 
[MODELA App Group] and click [mdx3p].  
MOELA Player will start　　　　　　　　　　　　　　　　　　　　　　

6. Import data in Modela Player (STL or DXF format)
(See Users manual P19)　

7. Choose Machine 

From [Option] menu, click [Machines…] Choose MDX-20 then click OK 　　　　　　　　　　
　　　　　　　　　　　　　　　　

Training guide
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8. Setting the printing device　　　　　　　　　　　　　　　　　　　　　　　　　　　　
　　　　　　　　　　　　　　　　　

From [File]menu, point to [Print Setup].  Choose MDX-20 then click OK　　　　　　　　　　
　　　　　　　　　　　　　

3

COM1 or COM2

Training guide

9. Set the Cutting Parameters (See users manual P19~20)

1) Set the cutting direction,  choose [from TOP]

2) Set the cutting depth.  Set the remain value[0]

3) Choose tool type.  Choose straight endmill dia. 3mm

4) Choose Material.  

5) Change cutting performance.  Choose  [Draft]

1

2

4
5
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10. Position the object data  
Position the object data at the center of material　　　

　　　　　　　　　　　　　　　　　　

Training guide

1) From [Option] menu, point to [Layout. . .]

2) Set origin Lower left X, Lower left Y.  Then set Margin [0]

How to decide the position

Sample object size

Material 100 x 100 x 15 (mm)

Object 85.1 x 85 x 6 (mm)　　

100 - 85 = 15 (mm)

15 / 2 = 7.5 (mm)

Lowe left X = 7.5. 

Lowe left Y = 7.5
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11．Set the Abstract

From [Option] menu, point to [Abstract], then

choose [OFF]　　　　　　　　　　　　　　　

Training guide

12. Choose material 　 (See User’s manual P20)

Choose material from material list..  (When SAN MODUR is not 
registered, see next pate.)　　　　　　　　　　　　　　　　

Click
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Training guide
(12.  Register new material)

You can register new material or customize the cutting parameter before you choose material.  
See Appendix1 (P41) for the detail. 　　　　　　　　　　　　　　

From [Option]menu, point to
[Custom Parameter].  Click [ADD]

Continue… See Appendix1.

13. Choose Tool path direction　

Choose Tool path direction for Draft (rough) 
and Fine (Finish).  From [Option]menu, point to 
Tool path direction.

For quick finish  : Draft X (or Y) Fine X(or Y)
For fine finish : Draft contour, Fine X + Y 
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14. Surfacing
Training guide

1)From [Option]menu, choose [layout. . . ]
2)Enter 0.5 for depth
3)Remove the check of [Automatic]
4)Enter width, length
5)Enter Lower Left X, Lower Left Y.
6)Click [Start] surfacing.  Then [Yes]

Sample information 
Width = Material width + Tool dia. (material 100 mm +  Tool  3mm) 

Length = Material length + Tool dia. (material 100 mm + Tool 3mm)

Lower left X, Y = -1.5  (Lower left coordinates should be tool radius 

minus to cut off the edge clear. Continue...



12

15. Surfacing
Training guide

Surfacing time ---about 5 minutes

Check the surface of material if it is 

completely flat.  Then click [OK] to return to

main display. 

If the surfacing is not flat yet, repeat the 

surfacing until you get the flat surface.  

You do not need to change the setting.  Just repeat.

Note:
*If the slant of surface is  big like (                   )

increase the surfacing depth value over 0.5. 
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16 Create tool path for front face．(Draft)
Training guide

Create tool path 
From [Option]menu, choose Tool Path direction Draft X direction

Click Tool path button Draft Contour direction
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17. Simulation on PC 　　　　　　　　　　　　

　　　　　　　　　　　　　　　　　　　　　　
　

Start Virtual MODELA and check the form and 
cutting information.　　　　　　　　　　　　
　　　　　　　　　　　　　　　

Training guide

1)From [File] menu point to [Output Preview].  
Virtual MODELA will start. 

2)From Simulation menu point to [Estimation].  
The [Cutting Data Information] will be shown.

<- Estimated Time
*Includes some
tolerance.

Simulation of
Draft contouring
cutting.
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18. Output cutting data (Front face, rough (Draft) cutting)

From [File] menu, choose [Output].  MDX-20 will start cutting.　　
　　　　　　　　　

Training guide
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19 Change cutting performance (Front face, Fine cutting)　　　　

Training guide

After finishing the Draft cutting, change the
cutting performance to Fine.

Click the Draft in the menu box

Click [DRAFT]button -> Change to [FINE]
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20 Create Tool Path and Simulate on PC 
for Fine cutting. 　　　　　　　　　　　　
　　　　　　　　　　　　　　　

Training guide

Tool path for finishing (X & Y) Virtual MODELA 2D simulation 

Create tool path for finishing

Virtual MODELA 3Dsimulation

Continue...
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21 Output cutting data (Front face, Fine cutting)
Training guide

From file menu, choose [Output].  The MDX will start cutting.

If you use only one tool for Draft cutting
and Fine, you can output the 
data successively.   In this case, 
keep the setting of MDX-20.

When you send Draft cutting 
data and Fine data 
successively, the dialog will be
as left.  The upper data is 
Draft and the under one is 
for Fine.
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Training guide
22. Cleaning the fallen cuttings　　

　　　　　　　　　　　　　　　　　
　　　　　　　　　　　　　　　　　

Finish the cutting.
Remove the cover

Press the VIEW key, 
and the table moves 
to front

Clean the cuttings
by vacuum cleaner

Put the cover on and 
press the VIEW key
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Training guide
23 Make pin holes　　　　　　　　　　　

Make pin holes by cursor functions of MODELA Player

Make 4 pin holes on frames 
around the material
4 points = Lower left, Upper left
Lower right, Upper right

First, decide the position 
of lower left pin hole. 
Layout lower left X - Tool dia. =X

7.5 - 3 = 4.5
Layout lower left  Y - Tool dia. = Y 

7.5 - 3 = 4.5

Check the position by this circle.
Exmaple : Work (Material)size  100x100x15  Object size 85.1x 85x 6 (X x Y x Z)(Unit :mm)
Upper Left X=4.5 (Layout LowerLeft X - Tool dia.) Upper Right X=95.6 (Layout LowerLeft X + Object X + Tool dia.)

Y=95.5 (Layout LowerLeft Y + Object Y + Tool dia.) Y=95.5 (Layout LowerLeft Y + Object Y + Tool dia.)

Lower Left X=4.5 (Layout LowerLeft X - Tool dia.) Lower Right X=95.6 (Layout LowerLeft X + Object X + Tool dia.)
Y=4.5 (Layout LowerLeft Y - Tool dia.) Y=4.5 (Layout LowerLeft Y - Tool dia.)

Continue...
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Training guide
24. Make pin holes

1) Enter the calculated X, Y, coordinate value

2) Click [CURSOR] key

3) Click [Yes]

4) The tool moves to the position you 
specified at No.1).  Then tool down the 
Z0 position.

5)Press the Tool DOWN key and make 
a pin hole about 10mm depth.

6)Repeat this process for other 3 positions 
and make 4 holes.

*Before you make a hole, mark on the tool 
by felt pen at 10mm.  It makes you easy to
find the depth. 

Mark by felt pen
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Training guide
25. Cleaning the cuttings and Mark the direction　　　　　

Remove the front cover Press VIEW key, the table moves to the front

Clean the cuttings by 
vacuum cleaner*Mark on the lower left corner with pen

*IMPORTANT
This mark is necessary to reverse the
material to correct direction 
for reverse side cutting. 
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Training guide

Measure the thickness by 
slide calipers or rulers

26. Remove the material
Remove the material from table

*If you cannot remove the material. . . 
Use a screw driver, awl etc. or put some

alcohol between material and table to
remove double-sided tape.

This measurement is to calculate the 
amount of surfacing for reverse side. 
Measure by 0.1 unit for precise modeling
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Training guide
27. Put the base material

Put on material for base at the same 
position of object material 

Put the front cover

Press VIEW key to release PAUSE
Press TOOL - DOWN key until the 
tip of tool reaches the surface
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Training guide
28. Surfacing the base material

Surface the base material by Surfacing function of MODELA Player.  See No. 14) Surfacing.

*In case of this training, the object material 
and base material are same size.

Surfacing size for base material 
Width = Material width + Tool dia. (material 100 mm +  Tool  3mm) 

Length = Material length + Tool dia. (material 100 mm + Tool 3mm)

Lower left X, Y = -1.5  (Lower left coordinates should be tool radius 

minus to cut off the edge clear.

MDX starts surfacing
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Training guide
29.Make pin holes on base material

Make pin holes on base material by Cursor function of MODELA Player

See No. 24 Make pin holes.
Make holes at the same place as
the object material.  
The depth of holes should be about 
14~15 mm.
(Length of pin : 18mm)

*Before you make a hole, mark 
the tool by felt pen at 14~15mm.  It 
makes you easy to find the depth.

Lower left Upper left Upper right Lower right



27

Training guide
30. Clean the cuttings by vacuum cleaner　　

See. No. 22 Cleaning the fallen cuttings.

31. Insert positioning pins in holes

Insert 3 positioning pins in holes.
(*Positioning pins are included in the accessory)

32. Put double-sided tape on the front face of 
the object material

*Remove the cuttings of the surface of 
material clearly before put the tape.　

Put tape at 4 places and remove the 
back paper.
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Training guide
33. Fix the object material on the base material

Turn the material left to 
right. (or right to left).  
Insert pins in the holes.

Stick it on the base material
strongly.  The mark should be 
at right corner now.

Get the object material 
ready. The mark should be
left lower corner first.

Put on front cover Release VIEW key

Press TOOL-DOWN key until
the tip of tool reaches the 
surface.

34. Set Z0
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Training guide
35. Surface the reverse side.

Surface the material by Surfacing function of MODELA Player

See.No.14 Surfacing

Enter the value for surfacing.  
Refer No. 26 Remove the material.
Material thickness - Object height =Surfacing depth
(  i.e. material thickness 14.5mm, 

object height 6 mm
surfacing depth = 14.5 - 6 = 8.5 mm)

Check the [Automatic]
MODELA Player surfaces object size 
only if it is checked. 

MDX starts surfacing.
Surfacing time varies 
depending on the depth.
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Training guide

36. Setting the cutting parameter for reverse side

　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　
　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　　

2) Cutting Depth

3) ~ 5) Material, Cutting 
performance, Tool dia. 

Click

Set [0] for 
remains

1) Cutting surface : Choose [bottom] 

2) Cutting Depth : Set the remains [0]

3) Tool : Set [3 mm, straight        ]

4) Material : Choose [SAN MODUR]

5) Cutting performance: Choose[DRAFT

Cutting 
performanc
e

1)Cutting Surface

1) Cutting surface

3) ~ 5)
2) Cutting depth Tool dia.

Material
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Training guide

37. Create tool path for Draft cutting （Rreverse side.）

See. 16 ~ 21 Front face cutting DRAFT ~ FINE

Cutting performance is same as front face cutting

Click tool path MODELA Player creates tool path (Contour )

From [Option]menu, point to [Tool path direction]. 
Then choose direction for DRAFT and FINE　　　　

For quick finish  : Draft X (or Y) Fine X(or Y)
For fine finish : Draft contour, Fine X + Y　　
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Training guide

38. Simulation on PC 　　　　　　　　　　　　

　　　　　　　　　　　　　　　　　　　　　　
　

Start Virtual MODELA and check the form and 
cutting information.　　　　　　　　　　　　　
　　　　　　　　　　　　　　

1)From file menu, point to Preview.  
Virtual MODELA will start. 

2)From Simulation menu point to [Estimation].  
The Cutting Data Information dialog will be shown.

<- Estimated Time
*Includes some
tolerance.

Simulation of
Draft contouring
cutting.
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Training guide
39. Output cutting data (Reverse side, rough (Draft) cutting)　　　　　　　　　　

From [File] menu, choose [Output].  MDX-20 will start cutting.
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Training guide

40. Change cutting performance (Reverse side, finish (FINE) cutting)

After finishing the Draft cutting, change the
cutting performance to Fine.

Click the Draft in the menu box

Click [DRAFT]button -> Change to [FINE]

Continue...
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Training guide
41 Create Tool Path and Simulate on PC for Fine 
cutting. 　　　　　　　　　　　　　　　　　　　　　
　　　　　　

Tool path for finishing (X & Y)

Create tool path for finishing

Virtual MODELA 3D

Virtual MODELA 2D simulation 
Continue...
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Training guide
42 Output cutting data (Reverse side, Fine cutting)

From file menu, point to [Output].  The MDX will start cutting.

If you use one tool for rough cutting
and finishing, you can output the 
data successively.   In this case, 
keep the setting of MDX-20.

When you send rough cutting 
data and finishing data 
successively, the dialog will be
shown as left.  The upper 
data is rough cutting data and 
the under one is for finishing.
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Training guide
43. Cleaning the fallen cuttings　　

　　　　　　　　　　　　　　　　　
　　　　　　　　　　　　　　　　　

Finish the cuttings.
Remove the cover

Press the VIEW key, 
and the table moves 
to front

Clean the cuttings
by vacuum cleaner

Put the cover on and 
press the VIEW key
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Training guide
44. Remove the object material from base.　　　　　　

Prepare screw driver, awl etc. 

Insert awl in lower
left corner

in lower right corner in upper right corner Pull out carefully

IMPORTANT!
Insert awl or screw driver at each corner of object.  
Then pull out object material VERY carefully.
Do NOT pull the object material quickly, or the object 
will be broken.
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Training guide
45. Remove the support lib.　　　　　

Prepare Nippers, Scissors, Cutter Knife,
Coping saw etc. to cut off the support lib, 
and also file, sandpaper to file.

Use nippers for this sample

Finish!

2)Remove object 
from frame

3)Cut off the remains
of support lib

4)File the remains of 
support lib smooth.

IMPORTANT!
When you cut the support lib, cut the 
nearest part to frame first, then cut off 
remains.  If you cut the nearest part of 
object first, the object might be cracked.

1)Cut the support lib.
(See IMPORTANT)
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Appendix1
What is SAN MODUR?
Chemical wood resin made by SANYO Chemical Industries Ltd.
http://www.sanyo-chemical.co.jp/index_e.htm

Register new material 
If your material is not listed, you can register it as new material or you can register your 
customize parameter as another material.

Register new material SAN MODUR

From [Option]menu, point to [Custom Parameter].  
Click [ADD] 　　　　　　　　　　　　　　

Continue...
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Register new material SAN MODUR
Appendix1

1) Click Add

2) Enter material name [SAN MODUR]

3) Click OK

4)Change the parameter
*The parameter of this material 
ZVS15mm/sec
Cutting in amount 2
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Appendix2
Positioning the reverse side.
You can set position of reverse side by 2 pins only.

Make pin holes on Left & Right center of frame or 
Top & Bottom center.  When you use only 2 pins, put 
double sided tape on the other frames and fix the material steadily.


